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1. Introduction to Kernel for Lotus Notes to Outlook
Welcome to the user manual for Kernel for Lotus Notes to Outlook - NSF to PST Software, the most powerful, 

professional and easy-to-use conversion software that helps you to convert unlimited NSF files and Domino 

Server Mailboxes. 

1.1 Using this Manual 

This user manual is intended to guide users on using Kernel for Lotus Notes to Outlook. We suggest that first time 

users should read this user manual completely and carefully before proceeding to use the software. However, if 

you are an experienced user, you can use the table of contents to find out information about the tasks that you 

need to perform by using Kernel for Lotus Notes to Outlook. You can use the table of contents to navigate through 

different sections of this user manual. The table of contents lists all the sections that are contained in this user 

manual in chronological order. The user manual comprises the following sections: 

• Introduction

• Getting Started

• Software Interface

• Convert NSF file to PST file

• Convert Domino Server Mailboxes

• Full Version

• Support

• Troubleshooting

• Legal Notice

1.1.1 List of Abbreviations 

Certain abbreviations have been used throughout this manual. For a clear understanding of the contents of this 

user manual, please go through the list of abbreviations, mentioned below, before reading the manual. 

NSF: Notes System Files 

PST: Personal Storage Files 

RTF: Rich Text Format 

MS: Microsoft 

RAM: Random Access Memory 

MB: Mega-Byte 

GB: Giga-Byte 
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1.2 About Kernel for Lotus Notes to Outlook 

Kernel for Lotus Notes to Outlook is an email migration tool for Lotus Notes email client that lets a user to migrate 

from Notes to Outlook and Exchange Server easily. A reliable, result-oriented software with high-performance 

percentage lets you convert your NSF files to PST files and access them with MS Outlook or directly lists in MS 

Exchange Server user profile. This software uses quick algorithms to convert NSF files to PST files and user 

mailboxes from Domino Server to Exchange Server. 

Kernel for Lotus Notes to Outlook supports direct migration from Lotus Notes to Exchange Server. The software 

accurately converts user's emails, calendar items, address books, appointments, tasks, Sent Items, drafts, notes, 

alarms, journals, calendars, and every other folder and item existing in the user's Lotus Notes account. Unlimited 

user accounts are easy to migrate from Domino Server to MS Exchange Server using this tool. The software 

proves to be much help for both administrators and individual Lotus Notes users. Companies, organizations 

switching from Lotus Domino server to MS Exchange Server can be relaxed with Kernel for Lotus Notes to Outlook 

as the software meets every need of an organizational switch. 

1.3 Salient Features 

Salient features of Kernel for Lotus Notes to Outlook include: 

• Converts unlimited NSF files to PST files

• Enables users to convert various NSF files into PST files easily. Moreover, it enables the user to save

converted NSF file into several Exchange mailboxes in a single attempt.

• Enables users to edit Lotus Notes or Outlook's folder name and migrate contents accordingly.

• Converts NSF files from Domino Server Mailbox(s).

• Supports UNICODE character conversion.

• Saves Converted File in PST or Exchange Server options.

• Provides three options to save the converted emails in three different text formats:

o Save item(s) in TEXT/HTML format- Fastest Speed

o Save item(s) in RTF format- Low Quality - Medium Speed

o Save item(s) in RTF format - Best Quality - Lowest Speed

• Accurately converts emails, attachments, contacts, calendars, appointments, journals, to-do item list,

sent mails, drafts, alarms, rules, group calendars, created categories, and every other folder which is

created in the NSF file for a specific user account.

• Supports every version of Lotus Notes, MS Outlook, Domino Server and MS Exchange Server to perform

the process of file conversion.

• Free demo version available to test the capabilities of the software before purchasing it that allows saving

10 items per folder of NSF file (Notes and Domino).
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1.4 Who Should Use this Software? 

Kernel for Lotus Notes to Outlook is an excellent tool indeed for system administrators, individuals, technicians, 

who need to migrate from Lotus Domino Server environment to Exchange Server environment or want to convert 

large NSF files from Lotus Domino Server to MS Exchange Server or MS Outlook. Performing migration is a bit 

tedious task, but with Kernel for Lotus Notes to Outlook, companies, organizations, individuals can feel relaxed. 

2. Getting Started
Now that you have understood the features and potential of Kernel for Lotus Notes to Outlook, you are ready to 

get a hand on experience of the software. To start migrating from Notes to MS Outlook, you will first need to 

download and install the software. It is strongly recommended that before installing Kernel for Lotus Notes to 

Outlook, you should go through the installation pre-requisites for the software to ensure that your computer is 

appropriately configured to run the software. 

2.1 Installation Pre-requisites 

The various pre-requisites for installing and running Kernel for Lotus Notes to Outlook can be broadly classified 

into two major categories – Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

• Pentium Class Processor

• Minimum 64MB RAM (128 MB recommended)

• 50 MB for Software installation

• Disk Space - Enough space to store the repaired files

 You should have at least 10 MB of free disk space if you want to save 10 MB of
converted data

2.1.2 Software Requirements: 

The software requirements for installing the software are as follows: 

Supported operating systems: 

• Windows Server 2000

• Windows Server 2003

• Windows Server 2008

• Windows Server 2008 R2

• Windows Server 2012
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• Windows Server 2012 R2

• Windows Server 2016

• Windows XP

• Windows Vista

• Windows 7

• Windows 8/8.1

• Windows 10

Supported Lotus Notes & Domino Server Versions 

• Lotus Notes 9.0.1, 9.0, 8.5, 8.0, 7.0, 6.5, 6.0

• Lotus Notes Domino Server 9.0.1, 9.0, 8.5, 8.0, 7.0, 6.5, 6.0

Supported MS Outlook Versions 

• MS Outlook 97, 98, 2000, 2002, 2003, 2007, 2010, 2013, 2016, 2019

Supported MS Exchange Server versions: 

• All versions of MS Exchange Server (Exchange Server 5.0, 5.5, 2000, 2003, 2007, 2010, 2013, 2016,

2019)

 MS Outlook and Lotus Notes should be installed on the host computer on which you are
performing the conversion. Also, Lotus Notes Domino Server should be in working condition
while using the Convert Domino Mailboxes feature.

2.2 Downloading Kernel for Lotus Notes to Outlook for the First Time 

After checking your computer with the prescribed system requirements for Kernel for Lotus Notes to Outlook, you 

can download and install the software on your computer. You can buy the full version of the software from any 

one of our authorized resellers – Digital River and 2Checkout.  

If you want to try using Kernel for Lotus Notes to Outlook before buying it, you can download the evaluation 

version from the following link: https://www.nucleustechnologies.com/lotus-notes-to-outlook.html 

 You can save the first 10 items of every folder of NSF file (Notes and Domino) to PST file
format using the evaluation version of Kernel for Lotus Notes to Outlook; however, to save the
entire converted items you need to purchase the Full Version.

2.3 Install Kernel for Lotus Notes to Outlook 

After downloading the installer file for Kernel for Lotus Notes to Outlook, you can install the software by running 

the file. To install Kernel for Lotus Notes to Outlook, perform the following steps:  

• Double-click the Kernel for Lotus Notes to Outlook software installer file.

https://www.nucleustechnologies.com/lotus-notes-to-outlook.html
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• Follow the on-screen instructions. The Setup Installation Completion screen will be displayed.

• Click Finish to launch the software. The main window of the software appears.

2.4 Start Kernel for Lotus Notes to Outlook 

To start Kernel for Lotus Notes to Outlook software, click Start > All Programs > Kernel for Lotus Notes to Outlook 

Alternatively, you can launch Kernel for Lotus Notes to Outlook by double-clicking the shortcut icon available on 

the desktop and Quick Launch icon. 

2.5 Uninstall Kernel for Lotus Notes to Outlook 

You may need to uninstall and re-install Kernel for Lotus Notes to Outlook. To uninstall Kernel for Lotus Notes to 

Outlook software, 

1. Click Start > All Programs > Kernel for Lotus Notes to Outlook > Uninstall Kernel for Lotus Notes to Outlook

A warning message will be displayed. 

2. Click Yes to uninstall Kernel for Lotus Notes to Outlook.

 Before proceeding to uninstall Kernel for Lotus Notes to Outlook, you must ensure that the
software is not running.

You can alternatively uninstall Kernel for Lotus Notes to Outlook from the Control Panel by performing the 

following steps: 

1. Click Start > Control Panel, and then double-click Add or Remove Programs icon.

2. Select Kernel for Lotus Notes to Outlook and click Remove.

A warning message will be displayed. 

3. Click Yes to uninstall Kernel for Lotus Notes to Outlook.

3. Software Interface
Now that Kernel for Lotus Notes to Outlook has been installed on your computer, you can start using the software 

after getting acquainted with the software interface. 

3.1 Menu-bar 

The menu bar of Kernel for Lotus Notes to Outlook comprises three main menus – File, Tools, and Help. 

3.1.1 File Menu 

The File menu of Kernel for Lotus Notes to Outlook appears as: 
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Figure 3.1 File Menu 

Menu items in the File menu: 

Field Name Field Description 

Add File(s) Select to add NSF file(s) for conversion 

Add Domino File(s) Select this option to add Domino mailboxes for the conversion 

Export Select to start the conversion process from NSF files to Exchange 

Server or PST files or Domino Server files to Exchange Server or PST 

files 

Exit Select to close Kernel for Lotus Notes to Outlook software 

3.1.2 Tool Menu 

The Tools menu comprises one menu item. 

Figure 3.2 Tools Menu 

Menu item in the Tools menu: 

Field Name Field Description 

Advance Settings Select this option to access ‘View Folders’ which are 

by default created by Lotus Notes. To view them, you 

need to activate the ‘Show View Folders’ option from 

the Advance Settings window. 

3.1.3 Help Menu 

The Help menu comprises three menu items. 
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Figure 3.3 Help Menu 

Menu items in the Help menu: 

Field Name Field Description 

Help Select to open User Help Manual of Kernel for Lotus 

Notes to Outlook software 

Software home page Select to visit software homepage on our website 

About Kernel for 

Lotus Notes to Outlook 

Select to know version and support information about 

Kernel for Lotus Notes to Outlook software 

3.2 Toolbar 

The toolbar in Kernel for Lotus Notes to Outlook software contains following buttons: 

Button Button Description 

Click to add and list .NSF file(s) for conversion 

Click to add and list Domino Server to Kernel 

for Lotus Notes to Outlook software for 

conversion 

Click to export/save selected.NSF file to PST or 

Exchange Server file format 

Click to remove NSF files that have been added 

before the Lotus Notes to Outlook conversion 

starts. 
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Click to preview NSF files that have been 

added before the Lotus Notes to Outlook 

conversion starts. Preview works only for 

Standard mode.  

Click to view software’s homepage on our 

website. 

Click to know version & support info about the 

software 

Click to buy the full version of the software 

4. Using Kernel for Lotus Notes to Outlook Software
Kernel for Lotus Notes to Outlook software can be used to migrate unlimited NSF data to Outlook and Exchange. 

The software allows its users to perform the following conversions: 

1. Convert NSF files to PST files

2. Convert NSF files to Exchange Server

3. Convert Domino Server files to Exchange Server

4. Convert Domino Server files to PST files

4.1  Convert NSF files to PST files 

Let’s see how Kernel for Lotus Notes to Outlook software performs the NSF files to PST files conversion. 

Step 1: Launch Kernel for Lotus Notes to Outlook software, and you will see the welcome screen like this. 
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Figure 4.1 Home Screen 

Step 2: Click the Add Local NSF File(s) button and select any number of NSF files for conversion: 



© KernelApps Private Limited 

Figure 4.2 Selection of NSF Files 

Selected NSF files will get listed in the Kernel for Lotus Notes to Outlook software for conversion. 
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Figure 4.3 Enlisted NSF File(s) 

Step 3: Select any NSF file and click the desired button. 

Click the Preview button to preview or click the Migrate button to save the files before or after seeing the 

preview. Here, the Preview button has been clicked to view email data. 
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Figure 4.4 Preview of NSF data 

Step 4: After the preview, click on the Migrate button. The following screen will be displayed. Select any one of 

them. Choose the Outlook PST mode and click OK. 

Figure 4.5 Saving Options 

Step 5: Define the PST folder path to save the converted file on your disk. Click OK. 
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Figure 4.6 Browsing PST Path 

Note: To perform bulk migration of NSF files, you can add a CSV file with Source and Destination details. 
Choose Map using CSV, click the Import from CSV option and add the CSV file. The CSV file format is like 
this: 
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Figure 4.7 Mapping with CSV 

Step 6: To save into multiple small PST files, you can use the Split PST option that splits the file into a defined size 

(in MB or GB). Define the Date Range by inserting the start date and end date. 

You can select the categories under the Select Categories option. Provide Folder filters by checking/un-checking 

Skip folder name "All" and Skip Hidden Views and Folders options. 

Check, different fields like "Exclude Folder(s)," and "Include Folder(s)" if you want to exclude or include any 

folder(s); click OK. 
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Figure 4.8 PST Options 

. 

Step 7: Kernel for Lotus Notes to Outlook software will display the following message. Click OK. 

Figure 4.9 Warning Pop-up Screen 

Step 8: Kernel for Lotus Notes to Outlook software displays the Saving Mode Selection window. You can choose the 

required option and continue with the saving procedure. 
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Figure 4.10 Saving Formats 

Step 9: The conversion process starts. On successful saving of the files, Kernel for Lotus Notes to Outlook software 

will display the following message: 

Figure 4.11 Saving Complete Message 

Hence, emails of NSF files are successfully saved into PST files, which now can be viewed with MS Outlook email 

client. 
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4.2  Convert NSF files to Exchange Server 

The Exchange option lets you access the MS Exchange Server and directly save emails of NSF file in user profiles 

created on MS Exchange Server, which are then easily accessed by the user from his/her MS Outlook email 

account. 

Step 1: Select the Exchange option. Click OK. 

Figure 4.12 Saving Options 

Step 2: Kernel for Lotus Notes to Outlook software will now ask for the Exchange Server details to get connected 

to the server. Provide the Domain Controller Name or IP Address, User Name with Domain, Exchange Server 

username and password as login credentials. If you are using Exchange 2016/2019 as a destination, click Use 

existing profile; your Exchange Server available will automatically get added. Select the option "Saving in Exchange 

Server 2013/2016/2019" if you are establishing a connection to an Exchange Server 2013/2016/2019. 

Figure 4.13 Exchange Credentials 
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Step 3:  After selecting the checkbox, the user can export all NSF files into the Exchange mailbox entered. If you 

do not select the checkbox, the software will prompt you to enter new Exchange Mailbox every time. It is 

recommended to close all Microsoft Outlook instances (if running).  

Use the first option to map using CSV. Click Import from CSV and choose the CSV file with mapping information. 

Figure 4.14 Adding mapped CSV file 

A mapped CSV file is shown like this. You can Download sample CSV file and export mapping details to CSV using 

Export to CSV option. 
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Figure 4.15 Example - mapped CSV file 

Step 4: Alternately, choose the Map automatically option. It will map your source and destination mailboxes 

automatically. Click Get Target Mailbox List to fetch target mailboxes. 
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Figure 4.16 Map Automatically option 

Step 5: Select the unmapped source mailbox and click Mapping. Select the target mailbox from the list and then 

click OK. Similarly, add all target mailboxes against each source mailbox and then click OK. 
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Figure 4.17 Mapping option 

Step 6: The Software then asks the users to enter the Date Range. Enter the Start Date and End Date for the 

conversion. Then insert that Date Range. You can enter more than one Date Range as a filter. Use Select 

Categories option to select the categories for conversion. Apply Folder filters by checking "Exclude All Folder" and 

"Skip Hidden Views and Folders". Provide the name of folders present in Lotus Notes that you want to exclude or 

include within Exclude Folder(s) / Include Folder(s) options. Provide the name of folders that you want to exclude 

and click OK. 
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Figure 4.18 Filter options 

Step 7: The software displays Saving Mode Selection window. Select the desired option and Click OK. 

Figure 4.19 Saving Formats 

Step 8: Kernel for Lotus Notes to Outlook software will start the saving process: 
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Figure 4.20 Saving in Progress 

Step 9: After successful saving, the following message is displayed: 
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Figure 4.21 Migration successful message 

Hence, Kernel for Lotus Notes to Outlook has successfully converted NSF files to Exchange Server. 

4.3  Convert Domino Server files to Exchange Server 

To export Domino Server NSF files to Exchange Server, perform following steps: 

Step 1: Launch Kernel for Lotus Notes to Outlook. 

Step 2: Click the Add Domino File(s) button. Kernel for Lotus Notes to Outlook software will display the "Domino 

Server File Selection" window where it will ask you to add the Domino Server Name or IP Address. 

Figure 4.22 Domino Server File Selection 

Step 3: Define the Domino Server Name or IP Address in the field or search for the Domino Server in a network 

with the help of Search Domino Server button. Kernel for Lotus Notes to Outlook software will search for the 

servers if you click the Search Domino Server button. 
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Figure 4.23 Domino Server File Selection 

Step 4: As the Kernel for Lotus Notes to Outlook software gets connected to the Domino Server, it will ask for the 

password to obtain access to the server. The screen to enter password would appear irrespective of the mode of 

Domino server selection. 
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Figure 4.24 Domino Server Credentials 

Step 5: Type the password and click the OK button.  

Figure 4.25 Domino Server password 

Step 6: Kernel for Lotus Notes to Outlook software will list the Domino Server name and its respective NSF files: 
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Figure 4.26 Added Domino Server files 

Step 7: Select NSF files and click Add button to add these NSF files in Kernel for Lotus Notes to Outlook software 

for conversion. The following message appears: 

Figure 4.27 Warning pop-up message 

Step 8: You can choose to add more or proceed. Click OK and continue with the conversion process. Here, you 

cannot preview the files by clicking the Preview button. Click the Migrate button to convert the files. 
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Figure 4.28 List of Domino files 

Step 9: Kernel software will display the saving options. Select the Exchange option and click the OK button. The 

software asks for the storage location. 

Figure 4.29 Saving Options 

Step 10: Provide the Domain Controller Name or IP Address, User Name with Domain, Exchange Server username 

and password as login credentials. If you are using Exchange 2016/2019 as a destination, click Use existing profile, 

your available Exchange Server will automatically get added. 
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Select the option "Saving in Exchange Server 2013/2016/2019" if you are establishing connection to an Exchange 

Server 2013/2016/2019. On selecting the checkbox, the user can export all NSF files into the Exchange mailbox 

entered. If you do not select the checkbox, the software will prompt you to enter new Exchange Mailbox every 

time. 

It is recommended to close every instance of MS Outlook (if running). 

Figure 4.30 Exchange Server Credentials 

Step 11: In the Mapping dialogue box, users are allowed to add mapped Source and Destination mailboxes using 

CSV file with Import from CSV option (as done in earlier conversions). 
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Figure 4.31 Mapping selection 

Step 12: Use Map automatically option, to map source with destination mailboxes. Click Get Target Mailbox List to 

fetch all target mailboxes. 
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Figure 4.32 Mapping selection 

Step 13: Select the source mailbox and click mapping button to add target mailbox against it from the full list. 

Similarly, do it with all source mailboxes to add desired target mailbox against it. Once done, click OK. 
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Figure 4.33 Add target mailbox 

All the source and target mailboxes get mapped now. Click OK. 

Figure 4.34 Mapped mailboxes 

Step 14: The following screen is displayed that allows the user to enter a Date range. Enter the date range for 

converting emails between the given date range and click OK. 

Select Categories option to select the categories for conversion. Apply Folder filters by checking "Exclude All 

Folder" and "Skip Hidden Views and Folders." Provide the name of folders present in Lotus Notes that you want to 

exclude or include within Exclude Folder(s) and Include Folder(s) options. 

It is recommended to check that Exchange Server is properly working when working with this option. 
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Figure 4.35 Filters options 

Step 15: Kernel for Lotus Notes to Outlook software then displays the Saving Mode Selection window. Select the 

desired option and click OK to continue. 

Figure 4.36 Saving modes 

Step 16: Kernel for Lotus Notes to Outlook software will start the Domino Server files to Exchange Server migration 

process. After successful conversion, Kernel for Lotus Notes to Outlook software displays the successful 

conversion message. 
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Figure 4.37 Migration process completed 

Hence, the software converts desired Lotus Notes Domino Server files into Exchange Server and saves at the 

given location. 

4.4  Convert Domino Server files to PST files 

The process of saving Domino Server files to PST files by selecting the Outlook PST option is similar to the 

Exchange option. The only difference between these two is their saving location. In the Outlook PST option you 

need to provide the saving location for the PST file. 

Step 1: Select the Outlook PST option. Click OK. 

Figure 4.38 Saving options 
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Step 2: Choose Map using CSV to add the mapped source and target PST files using Import from CSV option. You 

can export the mapping details to CSV file with Export to CSV option. 

Figure 4.39 Added Domino files 

Step 3: Kernel for Lotus Notes to Outlook software will ask you to define the file location (can be different for 

different source NSF files). 
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Figure 4.40 Browsing PST path 

Step 4: You can use Split PST filter to save into multiple small PST files of defined size (in MB or GB). Define the 

Date Range and insert that date range to convert NSF files from start date to end date into PST File. 

You can select the categories under the Select Categories option. Provide Folder filters by checking/un-checking 

Skip folder name "All" and Skip Hidden Views and Folders options. 

Check, different fields like Exclude Folder(s) and Include Folder(s)if you want to exclude or include any folder(s) 

and click OK. 
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Figure 4.41 Filters Application 

Step 5: The following window appears that asks the user to close all instances of MS Outlook (if running). Click OK. 

Figure 4.42 Warning pop-up message 

Step 6: The software displays Saving Mode Selection window. Select the desired option and click OK. 
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Figure 4.43 Saving modes 

Step 7: Kernel for Lotus Notes to Outlook software will now start the saving process and will display a successful 

message on the completion of saving of the files. When the conversion process completes, the software displays 

the location in which PST file has been saved. 

Figure 4.44 Migration Completed 

Hence, Kernel for Lotus Notes to Outlook software has completed the Domino files to PST files conversion. 
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5. Conclusion
The User Guide is easy to understand and helps to migrate Lotus Notes to Outlook and Exchange. Learn more 

about the product and its benefits here: https://www.nucleustechnologies.com/lotus-notes-to-outlook.html.  

6. Support
Connect to our experts immediately while facing any issues during installation, configuration, or associated 

matters: 

• 1-866-348-7872

• 0-808-189-1438

Additionally, you can connect with us at https://www.nucleustechnologies.com/Contact.html to submit your 

query, or chat with one of our support team.   

Moreover, you can write to us at the following email addresses: 

• sales@nucleustechnologies.com (for Sales Queries)

• support@nucleustechnologies.com (for Support Queries)

7. Copyright
KernelApps Private Limited accompanied Installation & configuration manual, and documentation is copyright 

of KernelApps Private Limited, with all rights reserved. Under the copyright laws, this user manual cannot be 

reproduced in any form without the prior written permission of KernelApps Private Limited. No Patent 

Liability is assumed, with respect to the use of the information contained herein.  

© KernelApps Private Limited. All rights reserved. 
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